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Nonlinear Model Parameter 
Estimation with implicit or 
explicit  models may include 
nonlinear systems of algebraic 
equations, mixed systems of 
differential and algebraic 
equations, as well as boundary 
value problems or partial 
differential equations. This 
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created to test the functionality 
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dealing with the nonlinear 
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reaction rate constants from 
multi-response data at 
different temperature levels 

with systems of ordinary differential equations. Experimental data at different temperature levels 
allows to estimate both the reaction activation energy and the reaction rate constant at a base 
temperature. 
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Reaction Mechanism and Reaction Rate Constants: Reaction Mechanism and Reaction Rate Constants: 
  

  

Atthheennaa  VViissuuaall  SSttuuddiioo  PPaarraammeetteerr  EEssttiimmaattiioonn  TTuuttoorriiaall  

� Start Athena Visual Studio 
� From the File menu select New. 
� You are in the Process Modeling tab. 
� Select the Parameter Estimation tab. 
� Click Estimation with Ordinary Differential Equations. 
� Select A Blank Document and click OK. 
� Enter your model data, initial conditions and equations, 

and the Athena solver data and options as described in this 
tutorial. 

  
When you are done: 

� From the File menu click Save. 
� Navigate to the folder where you wish to save and enter a 

proper filename for your model. 
� From the Build menu click Compile. 
� From the Build menu click Build EXE. 
� From the Build menu click Execute.
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Reaction Rate Model: 
 
The following model has been postulated as plausible candidate to describe the observed reactor 
concentration based on the available experimental data: 
 

 1 2
A B

A B
dC dCk C k C k C
dt dt

= − = − + 1 A  
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We wish to perform the following task: 
 
� Estimate the parameters {k1B, k2B, E1/RTB, E2/RTB } and their Highest Posterior Density 

Intervals [or Confidence Intervals]. 
 
The parameter initial guess at a base temperature   for this example is given in the table 
below: 

BT

 
MODEL INITIAL PARAMETERS  

1 0.5Bk =  2 0.5Bk =  

1 10.0
B

E
RT

=  2 10.0
B

E
RT

=  

025BT C=   
 
This example tutorial is already precoded in Athena Visual Studio. If you do not wish to type the 
code on your own you may access it by doing the following: 
 
� Open Athena Visual Studio 
� From the File menu click Open 
� Navigate to ..\Athena\Samples\Parameter Estimation Models folder 
� Select the PEM24.avw sample 
� Click OK 
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The experimental data at different levels of temperature and reaction time for this example are 
given below: 
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IImmpplleemmeennttaattiioonn  iinn  AAtthheennaa  VViissuuaall  SSttuuddiioo  
 
The following step by step process describes the model implementation in Athena Visual Studio 
 
� Open Athena Visual Studio.  
� From the File menu, choose New.  
� The Welcome: New Model Selection Panel window appears.       
 

 
 
� Select the Parameter Estimation tab 
� Select the  Estimation with Ordinary Differential Equations option. 
� Choose A Blank Document and click OK. 
 
Type your source code in the new window. The source code contains standard modeling sections 
(see description in the next sections below); it may also contain calls to the available math and 
engineering procedures as well as user-defined procedures. 
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WWrriittiinngg  tthhee  SSoouurrccee  CCooddee  
 
You must enter a minimum of four sections in order to create the parameter estimation model 
with a system of differential equations. The first section labeled @Initial Conditions is used to 
insert initial values for the state variables vector. The second section labeled @Model Equations 
is used to enter the implicit model equations. The third required section labeled   @Response 
Model is used to define the experimental responses(observations). The vector Y(i) is reserved in 
Athena to define these responses A section labeled @Gradient Vector is optional and may be 
used to enter the derivatives of the responses with respect to the adjustable parameters. The 
matrix dY(i,k) is reserved in Athena to define these derivatives . The fourth and final section 
labeled @Connect Parameters is used to connect the adjustable parameters and settings with 
the differential model parameters and constants. A data section not labeled by Athena Visual 
Studio may also be used to enter all the data pertinent to the model. The data section may also 
contain declaration statements for all model variables, parameters and constants.  This section, if 
used, must be the first one in the model. The declaration of the model variables, parameters and 
constants must be done in accordance the Athena Visual Studio syntax rules shown below: 
 

DDaattaa  SSeeccttiioonn  
 
In the data section the user simply enters the problem data and various constants. The data 
section also contains the declarations of problem variables, parameters and constants. For our 
example the user enters the experimental base temperature and the universal gas constant as 
shown in the code below. The Athena interpreter treats any line that begins with an exclamation 
mark ! as a comment. It is mandatory and strongly recommended that the users declare all the 
problem parameters and constants. All variables in Athena are either real double or single 
precision or integer long. Character and Logical variables are also allowed. The following source 
code may be entered for this example (If you use the Windows Copy and Paste commands to 
enter this code into your Athena Visual Studio project, please beware that invisible format 
symbols may also be copied and cause the compilation of your code to fail): 
 
! Declarations and Model Constants 
!--------------------------------- 
 Global k1,k2,k1B,k2B,E1B,E2B As Real 
 Global Tb,Temp,RxnTime,Rg As Real  
 
 Tb=32.5+273.15      ! Base Temperature, deg K 
 Rg=8.314            ! Universal Gas Constant, J/mol K 
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DDeeccllaarraattiioonn  ooff  VVaarriiaabblleess  
 
Global Variables: To declare global variables in the Athena Visual Studio environment you 
must use the  Global keyword as the examples below illustrate: 
 

Global    x, y, z, krate   As Real 
Global   Skount, Ncc   As Integer 
Global   myName As Character 
Global   myDecision As Logical 

 
In the above statements the variables x, y, z, krate will be treated as double precision and will be 
accessible by all modeling sections. Similarly the variables Skount, Ncc will be treated as integer 
and be accessible by all modeling sections. Character variables are assigned as Character*132 
from the Athena Visual Studio parser. Single precision variables cannot be declared Global. 
 
Vectors and matrices can be declared in a similar manner. The array size, type and number of 
dimensions are declared with the Global statement.  The elements of the array can be referenced 
by an integer index number, which runs from  one (or zero) to the maximum number declared in 
the Global statement: 
 

Global   y(10), c(0:5), a(4,50), b(2,4,6)    As Real 
Global   istate(5)   As Integer 

 
Local Variables: To declare local variables in the Athena Visual Studio environment you must 
use the  Dim keyword as the examples below illustrate:  
 

Dim    Temp, Pres   As Real 
Dim    TotalFlow   As Single 
Dim   i   As Integer 

 
In the above statements the variables Temp, Pres will be treated as double precision, where as the 
variable TotalFlow will be treated as single precision; these variables will be accessible only at 
the section where they have been declared. Similarly the variable i will be treated as integer and 
will be accessible only by the corresponding  modeling section where it has been declared. 
 
Vectors and matrices can be declared in a similar manner. The array size, type and number of 
dimensions are declared with the Dim statement.  The elements of the array are referenced by an 
integer index, which runs from  one(or zero) to the number declared in the Dim statement: 

 
Dim   c(10),  p(4,50)    As Real 
Dim   streamEnthalpy(10)    As Single 
Dim   irow(5)    As Integer 
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Parameter Statement: Use the Parameter keyword to define named constants as the examples 
below illustrate: 
 

Parameter   y=2.0, z=4.0  As Real 
Parameter  Skount=1, Ncc=4   As Integer 

 
In the above statements the variables y, z will be treated as double precision and their numerical 
values will be accessible by all parts of the modeling code. Similarly the variables Skount, Ncc 
will be treated as integer and their numerical values will be accessible through out all the 
modeling sections. The Parameter keyword is only allowed in the data section of the Athena 
Visual Studio modeling code. If it is used in the other modeling sections it will be ignored. You 
may view the generated Fortran code to see how the parser interprets the Parameter keyword. 
 
Important Note:  Always remember to declare all of your variables. Athena treats Real variables 
as double precision, Integer variables as 4-byte integers, Character variables as Character*132 
and Logical variables as .True. or .False. Single precision variables are only allowed if are 
declared as local with the Dim keyword. 
 
Fortran 95 Declaration Statements: You can insert Fortran 95 declaration statements by 
prefixing them with the double dollar sign. Below please see a list of Fortran 95 declaration 
statements that you can insert in your Athena code. Consult your Fortran 95 manual for the 
syntax rules of variable and constant declarations: 
 

$$Integer, Parameter:: dp=Kind(1.0D0) 
$$Integer, Parameter:: sp=Kind(1.0) 
$$Real(Kind=dp):: v1,v2 
$$Real(Kind=sp), Dimension(3):: a1,a2 
$$Integer:: I1, I2 
$$Character(Len=3):: s2,s3 
$$Character(Len=10), Dimension(2):: s1 
$$Logical:: Done 
$$Real(Kind=dp), Dimension(:), Allocatable:: w 

 
 
We are now going to describe in detail the various steps involved in writing an implicit model 
for parameter estimation in the Athena Visual Studio environment. The modeling code is NOT 
case sensitive.  
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IInniittiiaall  CCoonnddiittiioonnss  
 
In the Initial Conditions section the user must enter the initial values for the unknown state 
vector. The initial values are required by the algorithm in DDAPLUS to start the integration. The 
user must do the selection of the unknown state variables. The user must also make sure that 
he/she has a well-defined system where the number of equations is equal to the number of 
unknowns. The unknown state vector is represented by the variable U( ) in Athena. For our 
example we choose U(1) to represent the concentration of A and U(2) to represent the 
concentration of B . To enter the heading for the Initial Conditions section for our example: 
 
� From the Model menu choose Initial Conditions (or Hit F11 ) 
� Enter the source code as shown below for our example. 

 
@Initial Conditions 
 U(1)=Xu(4) 
 U(2)=Xu(5) 
 
The vector  Xu( ) is reserved by Athena Visual Studio to access the experimental settings. For 
our example Xu(1) is equal to the RunId, Xu(2) is equal to the reaction time, Xu(3) is equal to 
the reaction temperature, Xu(4) equal to the initial concentration of component A and Xu(5) 
equal to the initial concentration of the component B. 
 

MMooddeell  EEqquuaattiioonnss  
 
In the Model Equations section the user must enter the functions that describe the physical 
process. For example these functions may simply indicate the rate of change of the concentration 
of miscellaneous chemical components. The vector F( ) is reserved in the Athena environment to 
represent the values of these functions. For our example F(1) is  used to represent the rate of 
change of the concentration of A and F(2) is used to represent the rate of change of the 
concentration of B. In this section the user may make use of temporary variables to calculate 
intermediate variables such as, for example, the reaction rates. This facilitates the model writing 
process and it is also a sign of good programming skills. To enter the Model Equations section 
for our example 
 
� From the Model menu choose Model Equations (or Hit F11) 
� Enter the source code as shown below for our example. 

 
@Model Equations 
 F(1)=-k1*U(1) 
 F(2)= k1*U(1)-k2*U(2) 
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RReessppoonnssee  MMooddeell  
 
In the Response Model section the user must enter the responses. The vector Y( )  is reserved to 
enter the responses. For example Y(1) represents the first measured response, Y(2) the second (if 
present) and so on.  To enter the responses for your model: 
 
� From the Model menu choose Response Model (or Hit F11) 
� Enter the source code as shown below for our example. 

 
@Response Model 
 Y(1)=U(1) 
 Y(2)=U(2) 
 
 

CCoonnnneecctt  PPaarraammeetteerrss  
 
In the Connect Parameters section the user must connect the adjustable parameters and 
experimental settings with the model parameters and constants. The vector Par( ) is reserved to 
access the adjustable parameters, and the vector  Xu( ) is reserved to access the experimental 
settings. For example Xu(1) represents the first setting, Xu(2) the second if present and so on. To 
enter the Connect Parameters section for our model: [Notice how the reaction rate constants are 
calculated using the Arrhenius equation and how the temperature and reaction time are passed 
through to the Athena solver] 
 
� From the Model menu choose Connect Parameters (or Hit F11) 
� Enter the source code as shown below for our example. 

 
 
 
@Connect Parameters 
 k1B=exp(Par(1)) 
 E1B=Par(2) 
 k2B=exp(Par(3)) 
 E2B=Par(4) 
 
 RxnTime=Xu(2) 
 Temp=Xu(3)+273.15 
 
 k1=k1B*exp(Par(2)*(1.0-Tb/Temp)) 
 k2=k2B*exp(Par(4)*(1.0-Tb/Temp)) 
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TThhee  PPaarraammeetteerr  EEssttiimmaattiioonn  SSoollvveerr  
 
It is now time to access the Athena Visual Studio solver for Parameter Estimation in order to 
enter information about the adjustable parameters, the experimental observations and various 
other parameters that control the estimation algorithm, To do that: 
 
� From the Model menu choose Load Solver (or Hit F12) 
� Enter the solver parameters as shown below for our example 

 

 
 
From the Nonlinear Regression Parameters group enter: 
 
� The number of parameters (4) 
� The number of experiments  (48) 
� The number of responses (2) and 
� The number of settings (5) 

 
Optionally you may change the Number of Iterations, the Convergence and Parameter 
Tolerance, the Debug Print Level Control Flag and the Real and Integer Working Arrays space 
requirements. From the Estimation Solver Options group choose the type of estimation you are 
going to be using and optionally request a diagonal covariance if the Bayesian estimation has 
been chosen, or Check here to Test the Initial Parameter Values. The test call to model is a very 
useful option since it allows you to see how good is your initial parameter guess before you 
proceed with the estimation process. You also have the option to use a relative weighting factor 
of the observation vector in the estimation process. From the Derivatives Calculation group 
choose the method for the objective function gradient calculation and optionally enter the 
Relative Perturbation Step Size. Should you choose User Supplied Model Derivatives you must 
enter the section  @Gradient Vector when you enter the source code. 
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TThhee  AAddjjuussttaabbllee  PPaarraammeetteerrss  
 
Next select the Adjustable  Parameters tab on the Parameter Estimation Control Panel and 
enter the names of the parameters you wish to estimate, their initial guesses and optionally their 
lower and upper bounds, the relative perturbation step size for gradient computation and the size 
of the trust region. Notice that if a parameter is not checked in the check box next to it, will 
remain fixed at its initial value during the estimation. The following data have been inserted for 
our example: 
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TThhee  EExxppeerriimmeennttaall  OObbsseerrvvaattiioonnss  
 
Next select the Experimental Observations tab on the Parameter Estimation Control Panel and 
enter the observations and experimental settings. Optionally you may enter weights for each 
observation. Otherwise these weights are set equal to one by the Parameter Estimation solver. 
Windows Copy and Paste functions can be used to transfer your data from, say, an Excel 
spreadsheet. The following data have been inserted for our example: (partial list shown) 
 

 
 
Finally you may specify replicate experiments for performing lack-of-fit analysis and model 
discrimination.  
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EEnntteerriinngg  tthhee  IInnffoorrmmaattiioonn  aabboouutt  tthhee  KKiinneettiicc  MMooddeell  
 
Now click the Model button to enter the information on the differential equations. The DAE 
Solver Control Panel window appears 
 

 
 
In the System Identification group you will see that the option Pure Differential Equations E=I  
has already been selected for you. From the Integration Parameters group enter the Number of 
State Equations the Beginning and End of Integration(notice that the End of the Integration is 
equal to RxnTime=Xu(2), the second experimental setting), set Number of Output Points equal to 
zero and  change Debug Print Level Control Flag to –1 to suppress the printing from the DAE 
solver during the estimation process. Optionally you may change the Relative and Absolute State 
Tolerance fields. The Real and Integer Working Array Dimension fields are indicative of the size 
of the problem. If the default values are not large enough the solver will return with the message 
indicating the space requirements for your problem.  You may also need to examine if your 
model has a banded structure in which case you will have to check the appropriate options in the 
System Options group. After you make all your selections click OK.  When the Parameter 
Estimation control panel appears click OK and proceed to save and run your model. 
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SSaavviinngg  aanndd  RRuunnnniinngg  
 
You are now ready to save your model and run it. New files are labeled UNTITLED until they 
are saved. Keep in mind that the maximum number of characters in a line is 132; the maximum 
number of lines in a file is infinity. In order to save your project: 
 
¾ From the File menu, choose Save. This will save your model and create the Fortran code 

that will access the Parameter Estimation solver. The Save As dialog box appears. 
¾ In the Directories box, double-click a directory where you want to store the source file (or 

down a directories path to the appropriate directory.) 
¾ Type a filename (a filename cannot contain the following characters: \ / : * ? “ < > |) in 

the File Name box, then choose OK. The default extension given to a file is AVW.  
¾ To view the Fortran code that you have just created from the View menu choose Fortran 

Code. 
  
New files are labeled UNTITLED until they are saved. The maximum number of characters in a 
line is 132; the maximum number of lines in a file is infinity. Before you can save or close a 
window it must be active. To make a window active, either switch to the window (by clicking 
anywhere in it) or choose the window name or number from the Window menu.  
 
You may now choose to compile, build and execute your project; to do that. 
 
� From the Build menu choose Compile (or Hit F2) 
� From the Build menu choose Build EXE (or Hit F4) 
� From the Build menu choose Execute (or Hit F5) 
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NNuummeerriiccaall  RReessuullttss  
 
If everything goes well the results window will appear. In this window you can see the solution 
of your problem as well as various statistics pertaining to the solution process: 
 
 Number of Experiments...........................   48 
 Number of Parameters............................    4 
 Number of Responses.............................    2 
 Number of Settings..............................    5 
 
 EXIT GREGPLUS: SOLUTION FOUND. MODEL No. 1 
 
 STATISTICAL ANALYSIS 
 
 OBJECTIVE FUNCTION....................... -2.66465E+02 
 SUM OF SQUARES OF RESIDUALS..............  1.82052E-01 
 SUM OF SQUARES OF WEIGHTED RESIDUALS.....  1.82052E-01 
 ESTIMATED PARAMETERS FROM DATA...........            4 
 TOTAL OBSERVATIONS DATA COUNT IS.........           96 
 
                USER          OPTIMAL                                                        
 PARAMETER    ESTIMATES      ESTIMATES      95% MARGINAL HPD INTERVALS      PARAMETER STATUS 
  PAR(  1)   5.000000E-01   3.505220E-01     3.505220E-01 +- 3.310E-02      Estimated 
  PAR(  2)   1.000000E+01   1.452657E+01     1.452657E+01 +- 1.282E+00      Estimated 
  PAR(  3)   5.000000E-01  -4.532411E-01    -4.532411E-01 +- 3.903E-02      Estimated 
  PAR(  4)   1.000000E+01   9.800838E+00     9.800838E+00 +- 1.504E+00      Estimated 
 
 NORMALIZED PARAMETER COVARIANCE MATRIX 
   1.000 
   0.080  1.000 
   0.018 -0.012  1.000 
  -0.013 -0.026  0.011  1.000 
 
 EVENT     OBSERVED        PREDICTED        RESIDUAL     
   1      1.0000E+00      1.0000E+00      0.0000E+00 
   2      8.6690E-01      7.8943E-01      7.7474E-02 
   3      5.5900E-01      6.2319E-01     -6.4191E-02 
   4      5.3850E-01      4.9683E-01      4.1667E-02 
   5      3.4720E-01      3.9221E-01     -4.5012E-02 
   6      3.3450E-01      3.0962E-01      2.4879E-02 
   7      2.1570E-01      2.4442E-01     -2.8723E-02 
   8      2.0780E-01      1.9295E-01      1.4847E-02 
   9      1.3400E-01      1.5383E-01     -1.9830E-02 
  10      1.2910E-01      1.2144E-01      7.6629E-03 
  11      8.3200E-02      9.5865E-02     -1.2665E-02 
  12      8.0200E-02      7.5678E-02      4.5215E-03 
  13      5.1700E-02      5.9742E-02     -8.0424E-03 
  14      4.9800E-02      4.7162E-02      2.6379E-03 
  15      3.2100E-02      3.7600E-02     -5.4995E-03 
  16      3.0900E-02      2.9682E-02      1.2180E-03 
  17      1.9900E-02      2.3432E-02     -3.5317E-03 
  18      1.9200E-02      1.8498E-02      7.0247E-04 
  19      1.2400E-02      1.4602E-02     -2.2024E-03 
  20      1.1900E-02      1.1642E-02      2.5822E-04 
  21      7.7000E-03      9.1904E-03     -1.4904E-03 
  22      7.4000E-03      7.2552E-03      1.4480E-04 
  23      9.5000E-01      9.5000E-01      0.0000E+00 
  24      7.4670E-01      6.4748E-01      9.9219E-02 
  25      4.1470E-01      4.4129E-01     -2.6595E-02 
  26      3.4410E-01      3.0561E-01      3.8489E-02 
  27      1.9110E-01      2.0829E-01     -1.7191E-02 
  28      1.5860E-01      1.4196E-01      1.6637E-02 
  29      8.8100E-02      9.6756E-02     -8.6557E-03 
  30      7.3100E-02      6.5945E-02      7.1554E-03 
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  31      4.0600E-02      4.5669E-02     -5.0688E-03 
  32      3.3700E-02      3.1126E-02      2.5741E-03 
  33      1.8700E-02      2.1214E-02     -2.5141E-03 
  34      1.5500E-02      1.4459E-02      1.0414E-03 
  35      8.6000E-03      9.8546E-03     -1.2546E-03 
  36      7.1000E-03      6.7166E-03      3.8337E-04 
  37      4.0000E-03      4.6515E-03     -6.5155E-04 
  38      1.0300E+00      1.0300E+00      0.0000E+00 
  39      5.9690E-01      5.6359E-01      3.3312E-02 
  40      2.6500E-01      3.0838E-01     -4.3380E-02 
  41      1.7580E-01      1.7303E-01      2.7699E-03 
  42      7.8000E-02      9.4677E-02     -1.6677E-02 
  43      5.1800E-02      5.1805E-02     -4.8473E-06 
  44      2.3000E-02      2.8346E-02     -5.3462E-03 
  45      1.5200E-02      1.5510E-02     -3.1036E-04 
  46      6.8000E-03      8.7030E-03     -1.9030E-03 
  47      4.5000E-03      4.7622E-03     -2.6220E-04 
  48      2.0000E-03      2.6058E-03     -6.0581E-04 
 
   1      5.0000E-01      5.0000E-01      0.0000E+00 
   2      7.0750E-01      6.4185E-01      6.5646E-02 
   3      6.5520E-01      7.2607E-01     -7.0866E-02 
   4      8.4710E-01      7.6683E-01      8.0266E-02 
   5      7.0310E-01      7.7906E-01     -7.5956E-02 
   6      8.4750E-01      7.6918E-01      7.8316E-02 
   7      6.7010E-01      7.4406E-01     -7.3965E-02 
   8      7.7960E-01      7.0886E-01      7.0744E-02 
   9      6.0020E-01      6.6922E-01     -6.9023E-02 
  10      6.8380E-01      6.2448E-01      5.9317E-02 
  11      5.1770E-01      5.7836E-01     -6.0657E-02 
  12      5.8200E-01      5.3235E-01      4.9651E-02 
  13      4.3580E-01      4.8751E-01     -5.1714E-02 
  14      4.8550E-01      4.4456E-01      4.0939E-02 
  15      3.6080E-01      4.0559E-01     -4.4785E-02 
  16      3.9930E-01      3.6745E-01      3.1846E-02 
  17      2.9500E-01      3.3204E-01     -3.7039E-02 
  18      3.2500E-01      2.9937E-01      2.5633E-02 
  19      2.3920E-01      2.6939E-01     -3.0188E-02 
  20      2.6260E-01      2.4310E-01      1.9502E-02 
  21      1.9270E-01      2.1809E-01     -2.5385E-02 
  22      2.1090E-01      1.9540E-01      1.5502E-02 
  23      5.3000E-01      5.3000E-01      0.0000E+00 
  24      7.9050E-01      7.2670E-01      6.3797E-02 
  25      7.2850E-01      8.0513E-01     -7.6629E-02 
  26      9.0450E-01      8.1215E-01      9.2347E-02 
  27      7.1060E-01      7.7775E-01     -6.7146E-02 
  28      8.0550E-01      7.2016E-01      8.5340E-02 
  29      5.9720E-01      6.5197E-01     -5.4774E-02 
  30      6.5070E-01      5.8097E-01      6.9732E-02 
  31      4.6920E-01      5.1458E-01     -4.5384E-02 
  32      5.0100E-01      4.4958E-01      5.1422E-02 
  33      3.5580E-01      3.9022E-01     -3.4422E-02 
  34      3.7550E-01      3.3701E-01      3.8492E-02 
  35      2.6430E-01      2.8992E-01     -2.5623E-02 
  36      2.7710E-01      2.4866E-01      2.8438E-02 
  37      1.9400E-01      2.1416E-01     -2.0162E-02 
  38      4.7000E-01      4.7000E-01      0.0000E+00 
  39      8.8580E-01      7.8877E-01      9.7028E-02 
  40      7.7770E-01      8.5643E-01     -7.8734E-02 
  41      8.9160E-01      8.1141E-01      8.0195E-02 
  42      6.4180E-01      7.1786E-01     -7.6056E-02 
  43      6.6620E-01      6.1167E-01      5.4535E-02 
  44      4.5320E-01      5.0960E-01     -5.6404E-02 
  45      4.5450E-01      4.1863E-01      3.5871E-02 
  46      3.0250E-01      3.4376E-01     -4.1257E-02 
  47      2.9910E-01      2.7821E-01      2.0889E-02 
  48      1.9720E-01      2.2425E-01     -2.7047E-02 
 
 NUMBER OF ITERATIONS..............    5 
 NUMBER OF FUNCTION CALLS..........   30 
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GGrraapphhiiccaall  RReessuullttss  
 
If you wish to see various graphs of the estimation process from the View menu choose Solution 
Graphs, or click  The Athena Visual Studio graphics control panel appears: 
 

 
 
In this window fist we click Load to load the numerical results. Then in the Graph What group 
we select the x-variable (here Event Number) and the y-variables (here Observed and  
Predicted Values) and click Graph. You should see the monitoring graph that appears above. 
You may now click on the graph toolbar and modify the type, title, symbol, the style and 
miscellaneous other properties of the graph. You may also select to other graphs, like plotting of 
residuals, plotting observed vs. predicted values, or against any selected settings. 
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GGrraaddiieenntt  VVeeccttoorr  aanndd  SSeennssiittiivviittyy  AAnnaallyyssiiss  
 
The gradient vector is defined as the vector of derivatives of the objective function with respect 
to the model adjustable parameters. For our example there are four adjustable parameters 
therefore the gradient vector is defined according to the equations shown below: 
 

( )
1 2 3 4

, , ,
T

θ θ θ θ
⎡ ⎤∂Φ ∂Φ ∂Φ ∂Φ

∇Φ = ⎢ ⎥∂ ∂ ∂ ∂⎣ ⎦
θ  

 
The Athena Visual Studio parameter estimation solver calculates these derivatives by numerical 
perturbation of the adjustable parameters. The perturbation step size is optimized by the solver in 
order to minimize the round-off and truncation errors. The numerical calculation of the gradient 
vector is usually time consuming especially for large sets of experimental data or large number 
of differential equations. For each perturbation the system of the differential equations has to be 
solved for the entire set of the experimental data. 
 
Alternatively we can use the theory of sensitivity analysis for differential equations and compute 
the gradient vector of the objective function analytically. To do that, first observe that the 
relation between the model adjustable parameters that we are estimating and the reaction rate 
constants is given by the following equations: 
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1 1 2
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θ αθ

= + = −

= +
 

 
Therefore we obtain the following equations for the components of the gradient vector: 
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where e(u) is the residual vector, defined as the observed minus the predicted values vectors. The 
derivatives of the objective function with respect to the residual vector are calculated internally 
by the Athena parameter estimation solver. This calculation depends on the type of objective 
function used for the parameter estimation process (weighted least-squares for single-response  
or Bayesian estimation for multi-response). The remaining derivatives, 
 

1 1 2

and
ln ln ln lnk k k
∂ ∂ ∂ ∂

= =
∂ ∂ ∂ ∂ 2k

y u y u  

 
are simply the first order sensitivity coefficients of the state vector u(t) with respect to the 
reaction rate constants. These can be calculated either by numerical perturbation as it was done 
before in this tutorial, or by activating the sensitivity analysis option. In order to do we first load 
the solver (Hit F12). The Parameter Estimation Control Panel appears: 
 

 
 
In the Gradient Calculation group we select User Supplied Response Derivatives and then click 
the Model control button. The DAE Solver Control Panel appears: 
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We then select the Sensitivity Analysis tab. In the Sensitivity Analysis group we first click 
Sensitivity Analysis with Respect to Model Parameters and also Check here to Normalize the 
Sensitivity Functions. Next from the drop down menu we select the reaction rate constants k1 and 
k2. This action will force the DAE Athena solver to solve the differential equations and also 
calculate when needed the first order sensitivity coefficients: 
 

1 2

and
ln lnk k
∂ ∂

∂ ∂
u u  

 
We now click OK to unload the Athena solvers and hit F11 to enter the section for the Gradient 
Vector. For our example we enter the code shown below: 
 
@Gradient Vector 
 dY(1:2,1)=U(1:2,2) 
 dY(1:2,2)=U(1:2,2)*(1.0-Tb/Temp) 
  
 dY(1:2,3)=U(1:2,3) 
 dY(1:2,4)=U(1:2,3)*(1.0-Tb/Temp) 
 
We are now ready to build and execute the parameter estimation problem. If we do that, we 
obtain exactly the same numerical results as before by we now observe that the number of 
function (model) call drops from 30 to 10. This results in a reduction of the computer execution 
time by a factor of three which is a considerable amount especially for very large problems.  
 
Note:  Please read the Differential Equations Tutorial or the Athena Knowledge Base for 
detailed  information on how the Athena solvers store the first order sensitivity functions. 
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